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mum extent permitted by applicable
law, Agilent disclaims all warranties,
either express or implied, with regard
to this manual and any information
contained herein, including but not lim-
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1 Introduction

1 Introduction

Install the Quant-My-Way Flavors Setup Program 6
Open the Quant-My-Way Flavors Setup Program 8

The Agilent MassHunter Workstation Quantitative Analysis B.09.00 software
provides tools to customize, save, and share a Quantitative Analysis flavor.

A MassHunter Quantitative Analysis flavor is a user interface with a specific set
of tools and options. The Quantitative Analysis software provides a preset
number of system flavors designed for several instruments and applications.

Use the Quant-My-Way Flavors Setup program to create customized
Quantitative Analysis flavors that display the tools and menu options you need
for your laboratory or function. Your custom flavors can then be saved, updated,
and shared with others in your organization.

Quant-My-Way Flavors Setup Familiarization Guide 5



1 Introduction

Install the Quant-My-Way Flavors Setup Program

Install the Quant-My-Way Flavors Setup

Program

The Quant-My-Way Flavors Setup program can be installed alone or with any
other Quantitative Analysis feature during the MassHunter Workstation
Quantitative Analysis B.09.00 installation. The Quant-My-Way Flavors Setup
program should be installed on the workstation where a user will be creating and
editing custom flavors.

You can install the Quant-My-Way Flavors Setup program during the MassHunter
Workstation Quantitative Analysis installation (“Install Quant-My-Way Flavors
Setup during installation”), or it can be installed after Quantitative Analysis has
already been installed (“Install Quant-My-Way Flavors Setup after

installation” on page 7.

Install Quant-My-Way Flavors Setup during
installation

1 During the MassHunter Workstation Quantitative Analysis B.09.00
installation, on the Features screen, select Quant-My-Way Flavors Setup
Tool.

b Agilent MassHunter Workstation x

MassHunter Please choose features to install:

Installer Agilent MassHunter Workstation Quantitative Analysis B.09.00
[C] Blank Subtraction Add-in

[7] Peak Annotations Add-in

[C] Zero Total Compound Add-in

Features Quant-My-Way Flavers Setup Tool

Configure 7] Agilent MassHunter Workstation Quantitative Analysis Reporting B.09.00
PDF Reporting Templates

PDF ReportBuilder Templates

Excel Addin files

Excel Reporting Templates - English (Letter)

Excel Reporting Templates - English (Ad)

Excel Reporting Templates - QRS

Excel Reporting Templates - Chinese (Simplified)

Maintenance

Review

Excel Reporting Templates - Japanese
Agilent MassHunter Workstation Report Builder B.09.00

gilent Technologies

Back Next Cancel

2 Click Next, and continue to complete the installation.

Quant-My-Way Flavors Setup Familiarization Guide



1 Introduction

Install Quant-My-Way Flavors Setup after installation

Install Quant-My-Way Flavors Setup after

installation

1 If the MassHunter Workstation Quantitative Analysis B.09.00 software has
already been installed, from the Windows Control Panel, open Programs and

Features.

2 Select Agilent MassHunter Workstation Quantitative Analysis B.09.00, and

click Change.

[ Programs and Features

Control Panel Home

View installed updates

& Tum Windows features on or

Install a program from the
network

« « 4 [ » Control Panel > Programs > Programs and Features )

Search Programs

Uninstall or change ~ -ogram

To uninstall a program, «rom the list and then click Uninstall, Change, or Repair.

Organize ~  Uninstall | Change

Name
B8 Adobe Acrobat Reader DC

2] Agilent MassHunter Workstation Quantitative Analysis .09.00
&) Agilent MassHunter Workstation Repert Builder B.09.00

Agilent Software Verification Tool B.01.01
-

Publisher
Adobe Systems |...

hanlnnier G0 snd G IMS lear Manuslc Inctallar
Agilent Technologies, Inc. Product version: 9.0.630.0
Size: 2.31GB

Anilant Tarhanla

Agilent Technolo...
Agilent Technolo...
Agilent Technolo...

[m] x

=~ 9
Version e
17.009.20058
90,6300
9.0630.0
510100

115

3 Onthe Agilent MassHunter Workstation Installer Maintenance screen, click

Change.

4 On the Features screen, select Quant-My-Way Flavors Setup Tool.

MassHunter
Installer

Maintenance
Features
Configure

Review

lent Technologies

Agilent MassHunter Workstation
Please choose features to install:

Agilent MassHunter Workstation Quantitative Analysis B.09.00
[ Blank Subtraction Add-in
[T Peak Annotations Ad-in
[l Zero Total Compound Add-in
Quant-My-Way Flavors Setup Tool

1] Agilent MassHunter Workstation Quantitative Analysis Reporting B.09.00
PDF Reporting Templates
PDF ReportBuilder Templates
Excel Addin files
Excel Reporting Templates -
Excel Reporting Templates -
Excel Reporting Templates -
Excel Reporting Templates - Chinese (Simplified)
Excel Reporting Templates - Japanese

Agilent MassHunter Workstation Report Builder B.09.00

English (Letter)
English (44)
QRS

Back

5 Click Next, and continue to complete the installation.

Quant-My-Way Flavors Setup Familiarization Guide
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1  Introduction
Open the Quant-My-Way Flavors Setup Program

Open the Quant-My-Way Flavors Setup
Program

Windows 7: Select Windows Start > All Programs > Agilent MassHunter
Quantitative Analysis Tools > Quant-My-Way Flavors Setup.

1 Agilent
1 MassHunter Workstation
E Quantitative Analysis (M5) (OpenLA
E Quantitative Analysis (QQQ) (Openl
E Quantitative Analysis (Q-TOF) (Oper
E Quantitative Analysis (TOF) (OpenLy
[#7 Report Builder B.08.00
& Report Builder B.09.00
IZ}J:Q Unknowns Analysis (OpenLAB)
. Quantitative Analysis Tools =
o ATM Configuration
|4] Check Batch Files
B, Library Editor
B3 Method Comparison
[7] Method Histary
[57 Quant-My-Way Flavors Setup |
]fE'rl Repair Quantitative Analysis nep
é,'?, Report Task Queue
‘E;.-" Report Task
Restore User Settings
I RT Calibration
[55] Setup Desktop Icons -

4  Back

| |Search programs and files b |

8 Quant-My-Way Flavors Setup Familiarization Guide



1  Introduction
Open the Quant-My-Way Flavors Setup Program

Windows 10: Select Windows Start > All Programs > Agilent MassHunter
Quantitative Analysis Tools, and open the Quant-My-Way-Flavors Setup

program.
| l@ = | Tools - O X
Home Share Wiew v 0
4N <« Shortcuts » Cuant » Tools v O Search Tools el
& OneDrive ~ Name Date modified Type ~
[ This PC ‘a ATM Configuration 7/14/2017 11:01 AM  Shortcut
T ',j Check Batch Files 1711:01 AM  Shortcut
B Desktop 72 Method Comparison /2017 11:01 AM  Shortcut
Documents 75 Method History 1711:01 AM  Shortcut
; Downloa ',j_'zl Quant-My-Way Flavors Setup 472017 3:56 PM Shortcut
J’! Music ‘,E‘ Repair Quantitative Analysis Reporting 17 11:03 AM  Shortcut
[&] Pictures ‘t,'f-', Report Task Queue 42017 11:01 AM  Shortcut
B Videos &) Report Task 1711:01 AM  Shortcut
i [7=] Restore User Settings 2017 11:01 AM  Shortcut
‘ams Local Disk (C:) o _ _
- ) RT Calibration 71472017 11:01 AM - Shertcut
- L=l T 7% Setup Desktop Icons 7/14/2017 11:01 AM  Shortcut v
= Agilent GC \Ti v < >
11 items f
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1  Introduction
Open the Quant-My-Way Flavors Setup Program
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2 Create and Manage Flavors

2 Create and Manage Flavors

Create a Root Folder Location to Store Custom Flavors 12

Create a Flavor 14

Use the Quant-My-Way Flavors Setup program to create a custom flavor and
manage your existing custom flavors and folders.

Quant-My-Way Flavors Setup Familiarization Guide
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2 Create and Manage Flavors
Create a Root Folder Location to Store Custom Flavors

Create a Root Folder Location to Store
Custom Flavors

The root folder is the directory folder where you will store your flavors. You can
use any convenient location in your directory.

1 On the Flavor Root screen, click Open Root Folder.

Agilent MassHunter Quant-My-Way Flavors Setup EE =

Open Root
Folder

Manage

Flavor Root ¢« | | Manage Flavors

Manage Flavors Flavor root folder:

Flavors:

New Copy Edit Delete Test

Flavor Root

2 Navigate to an existing folder, or create a New Folder, and click Select Folder.

Select Folder X
« v N am » ThisPC » Local Disk (D:) v B l:yarch Local Disk (D) p-]
Organize = New folder E- @
[ This PC - Name . Date modified Type
; Desktop MassHunter B/ 0:32 AM  File folder

@ Documents My Root Folder T/5/2017 4:46 PM File folder
‘ Downloads

J’I Music

&= Pictures

B videos

‘i Local Disk (C:)

- Local Disk (D:) wlc

Folder: | My Root Folder

Select Folder Cancel

12 Quant-My-Way Flavors Setup Familiarization Guide



2

Create and Manage Flavors
Create a Root Folder Location to Store Custom Flavors

The Flavor root folder path is displayed, and the existing Flavors are listed.

[] 2 Agilent MassHunter Quant-My-Way Flavors Setup - Flavor 1 -0 x

[T

OpenRoot  Deplay
Folder

Manage

Flavor Root ¢« | | Manage Flavors
TR RIS Flavor root folder:
D:\My Root Folder

Flavors:

New Copy Edit Delete Test

Flavor 1

| Fiavor2

Flavor Root

Quant-My-Way Flavors Setup Familiarization Guide 13



2 Create and Manage Flavors
Create a Flavor

Create a Flavor

Create a flavor based on a standard system flavor, and then modify it as needed
for display name, Batch Table, ribbon options, sample types, outliers, or by
adding your own custom ribbon buttons and menus.

In this example, we will create a QQQ flavor that simplifies the user interface to
include only the functions needed to perform routine data analysis. The method
development functionality will be removed, as well as other non-essential data
analysis tools.

1 Onthe Flavor Root screen, click New.

~ . Agilent MassHunter Quant-My-Way Flavors Setup - Flavor 1 Po=- 0 %

[h ©

‘Open Root Deploy
Folder

Manage

Flavor Root ¢« || Manage Flavors

Manage Flavors Flavor root folder:

D:\My Root Folder
Flavors:

New Copy Edit Delete Test

Flaver 1
Flavor 2

Flavor 3

Flavor Root

2 Enter a Folder name. This name will be used as the flavor name in the root
folder. It will also be used as the default display name of the desktop icon and
user interface of your flavor unless the display name is changed in the
general settings. For this example, enter Vanilla.

3 Select a standard system flavor Instrument on which to base your flavor.

14 Quant-My-Way Flavors Setup Familiarization Guide



2 Create and Manage Flavors
Create a Flavor

4 Click New.

New Flavor x

Folder name:  Data Analysis

Instrument: Qaa, -

A folder is created in your root folder containing the configuration file
(startup.xml) for your flavor.

| - Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis ?o=- 0 X

Ch @

Open Root Deploy
Folder

Manage

Flavor Root <« | Manage Flavors
i rapE(Rae Flavor root folder:
D:\My Root Folder

Flavars:

New Copy Edit Delete Test

Data Analysis

Flavor 1
Flavor 2

Flavor 3

Flavor Root

Continue your customization by updating the Batch Table, ribbon options,
sample types, outliers, or by adding your own custom ribbon buttons and
menus. See “Customize a Flavor” on page 17.

Quant-My-Way Flavors Setup Familiarization Guide 15



2 Create and Manage Flavors
Create a Flavor
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3  Customize a Flavor

3 Customize a Flavor

Remove Batch Table Columns 18
Customize the Quant-My-Way Ribbon 22

Create a Custom Ribbon Button 25

Update your flavor with a new display name, Batch Table, ribbon, sample type,
outliers, or with your own custom ribbon buttons and menus.

Quant-My-Way Flavors Setup Familiarization Guide
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3  Customize a Flavor
Remove Batch Table Columns

Remove Batch Table Columns

1 On the Flavor Settings > Batch Table Settings screen, select Flat Table
(Multiple Compounds) from the Default Batch Table Layout list.

2 Select Flat Table (Multiple Compounds) from the Batch Table Layout
list. Remove the following Default Visible Columns:

= - Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis P - 0 X%
Reload Reset to Save
Settings  Default Settings
Batch Table Settings
Flavor Settings ¢ || Batch Table Settings

General Settings Batch Table Layout

Batch Table Settings Default Batch Table Layout: | Flat Table (Multiple Compounds) -

Column Labels

Ribbon Settings Default Visible Columns

sample Types Batch Table Layout: | Flat Table (Multiple Compounds) -

Outliers Table: sample -

Available Columns Default Visible Columns
Acq Operatar £ Quantitation Message Summary
Acq. Date-Time {Inst.} Qutlier Summary
Acqg. Method File Name
Add >> ~
Acg. Method Path Data File
Amt. <<Remave Type v
Approved Level
Balance Acg. Date-Time
v

Flavor Settings

18 Quant-My-Way Flavors Setup Familiarization Guide



3

Customize a Flavor

Remove Batch Table Columns

Quantitation Message Summary
Outlier Summary

Data File

Type

Level

Acq. Date-Time

&= s Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis

Ch ©

Reload  Resetto Save
Settings  Default | Settings

Batch Table Settings

Flavor Settings ¢ || Batch Table Settings

General Settings Batch Table Layout

Batch Table Settings Default Batch Table Layout: | Flat Table (Multiple Compounds) -
Column Labels

Ribbon Settings Default Visible Columns
Sample Types Batch Table Layout: | Flat Table (Multiple Compounds) M
Outliers Table: Sample .
Available Columns: Default Visible Columns:

Acg Operater ) Quantitation Message Summary

Acq. Date-Time (Inst.) Outlier Summary

Acq. Method File Name

Add >> A~

Acq. Method Path Dana File

Amt. <<Remove Type v

Approved Level

Balance Acg. Date-Time |

v

Flavor Settings

Quant-My-Way Flavors Setup Familiarization Guide
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3

20

Customize a Flavor
Remove Batch Table Columns

3 Select Compound Results from the Table list.

m - Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis

Reload Reset 1o Save

Settings  Default | Settings
Batch Table Settings

General Settings
Batch Table Settings
Column Labels
Ribbon Settings
Sample Types

Outliers

Flavor Settings

Flavor Settings & || Batch Table Settings

Batch Table Layout
Default Batch Table Layout: | Flat Table {Multiple Compounds) -

Default Visible Columns
Batch Table Layout:  Flat Table (Multiple Componds) -
Table: Compound Results -

Available Columns:. Default Visible Columns:

Alternative Peak RT Diff. ~ RT
Alternative Target Hit Final Conc.
Ar=a Accuracy
Add>> ~

Area Cor. Resp.
Baseline End Original <<Remove ~
Baseline Start Original

BLDraw

Figure 12.

4 Remove the following Default Visible Columns:

*RT

+ Accuracy

Ch 9

Reload Reset to
Settings Default

Flavor Settings
General Settings
Batch Table Settings
Column Labels
Ribbon Settings
Sample Types

Outliers

Flavor Settings

Batch Table Settings

& | | Batch Table Settings

Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis E = R

Batch Table Layout
Default Batch Table Layout: | Flat Table (Multipie Compounds) -

Default Visible Columns
Batch Table Layout: | Flat Table (Multiple Compounds) -
Table: Compound Results -

Available Columns: Default Visible Columns:

Altemnative Peak AT Diff. ~ RT
Alternative Target Hit Final Conc.
Area Accura
Add >> ) ~

Area Cor. Resp.
Baseline End Original <<Remove v
Baseline Start Original

BL Draw

Quant-My-Way Flavors Setup Familiarization Guide



3  Customize a Flavor
Remove Batch Table Columns

5 Click Save Settings.

Reload Reset to
Semings Default

Batch Table Settings

Flavor Settings
General Settings
Batch Table Settings
Column Labels
Ribbon Settings
Sample Types

Outliers

Flavor Settings

Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis

<« || Batch Table Settings
Batch Table Layout
Default Batch Table Layout: | Flat Table (Multiple Compounds)
Default Visible Columns
Batch Table Layout: | Flat Table [Multiple Compounds)
Table Compound Results

Available Columns:

Accuracy ~
Alternative Peak RT Diff.
Alternative Target Hit
Add >=
Area
Area Cor. Resp. <<Remave

Baseline End Original

Baseline Start Original

Default Visible Columns:

Final Conc.

Quant-My-Way Flavors Setup Familiarization Guide
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3  Customize a Flavor
Customize the Quant-My-Way Ribbon

Customize the Quant-My-Way Ribbon

1 On the Flavor Settings > Ribbon Settings screen, remove the following:
+ Method tab

B - Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis ?P - 0 X%

Ch ©

Reload Reset to Save
Settings  Default Settings

Ribon Settings

Flavor Settings & || Ribbon Settings

B Choose window to customize:
General Settings

Main Window M
Batch Table Settings ~
Choose commands from: Customize the Ribben, Toolbar, Menu:

Column Labels Al - Ribbon Tabs -
Ribbon Settings

# of Levels: ~ File ="
Sample Types

<Separator> [T Heme o=
Outliers N

About Quantitative Analysis View =)

Accept Assistant Curve Method =™

Accuracy & Ll Tools == A

Actions << Remove v

Add Calibration

Add Column

Add Samples

Add/Remove Columns

Add-ns

Advanced Tasks - New 7] [ Propertes

Flavor Settings
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3  Customize a Flavor
Customize the Quant-My-Way Ribbon

+ Calibration menu (Home > Analyze)
* Integrate menu (Home > Analyze)
+ Clear Results button (Home > Analyze)

+ Open Report Folder button (Home > Report)

Ch ©

Reload Reset to Save

Settings Default Settings
Ribon Semings
Flavor Settings & || Ribbon Settings
‘Choose window to customize:

General Settings
Main Window

Batch Table Settings
Choose commands from:

Column Labels Al
Ribbon Settings

= - Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis

# of Levels:

Sample Types
<Separator>

OQutliers B
About Quantitative Analysis

Accept Assistant Curve

Accuracy [

Actions

Add Calibration

Add Column

Add Samples

Add/Remove Columns

Add-Ins

Advanced Tasks v

Flavor Settings

Customize the Ribbon, Toolbar, Menu:

Ribbon Tabs
File =™
4 [N Home =
Batch
[ samples
Add >> 4 <) Analyze
<< Remove X Analyze [~
Quantitate |~
(Calibration
Integrate | -
Clear Results
[ Rreport
New « || Properties

* Queue Viewer button (Home > Report)

- Edit Report Method button (Home > Report)
+ Library Search Results button (Home > Report)

Quant-My-Way Flavors Setup Familiarization Guide
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3  Customize a Flavor
Customize the Quant-My-Way Ribbon

« Library Search Reports menu (Home > Report)

- Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis ?- 0 X%
Reload Reset to e
Settings  Default Settings
Ribon Sewings
Flavor Settings & | Ribbon Settings
General Settings Choose \lfmdow to customize:
Main Window -
Batch Table Settings 5
Choose commands from Customize the Ribbon, Toolbar, Menu:

Column Labels Al - Ribbon Tabs -

Ribbon Settings
# of Levels: & File o=

Sample Types
<Separator> 4 [N Home =

OQutliers B
About Quantitative Analysis Batch
Accept Assistant Curve [T Samples
Accuracy | Add > +) Analyze 7S

=
Actions < Remove a [ Report Y
Add Calibration (% Generate Report
Add Column Open Repart Falder
Add Samples Queus Viewer
Add/Remove Columns Edit Report Methad
Add-Ins Library Search Results w
- Advanced Tasks v . New | ——
Flavor Settings
2 Click Save Settings.
|| - Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis T = X

Ch ©

Reload Reset to ve
Settings Default Semings

Ribon Settings

Flavor Settings & || Ribbon Settings

Choose window to customize:
General Settings

Main Window A
Batch Table Settings ~
Choose commands from: Customize the Ribbon, Toolbar, Menu:

Column Labels Al - Ribbon Tabs -
Ribbon Settings

#of Levels: 2 File o=
Sample Types

<Separator> 4 [ Home o=
Outliers B

About Quantitative Analysis Batch

Accept Assistant Curve [if: Samples

Accuracy Add >> +) Analyze 7

. =

Actions ~ S Rea o 4[4 Report ~

Add Calibration @ Generate Repart

Add Column

View (="

Add Samples Tools s

Add/Remove Columns

Add-ins

Advanced Tasks v New - Properties...

Flavor Settings
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3 Customize a Flavor

Create a Custom Ribbon Button

To create a custom ribbon button in the Quant-My-Way Flavors Setup program,
you must create Python script for the button functionality. The script file (.py)
must be saved in a Tools folder within your custom flavor folder.

In this example, the script ZeroExceptionPeaks.py would be saved in
D:\MassHunter\configuration\Quant\flavors\Vanilla\tools\. The Vanilla flavor is
provided with the Quantitative Analysis software. To install the Vanilla flavor after
Quantitative Analysis is installed, do the following.

1 From the Windows Start menu, go to All Programs > Agilent > MassHunter
Workstation > Quantitative Analysis Tools > Setup Desktop Icons.

2 Under Pre-Configured Flavors, select Vanilla.
3 Click OK.

Quant-My-Way Flavors Setup Familiarization Guide 25



3  Customize a Flavor
Create a Custom Ribbon Button

1 Select the Analyze menu in the right pane (Home > Analyze).

mo- Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis ? - 0 %

Ch ©

Reload Reset to
Settings Default

Ribon Settings

Flavor Settings &« || Ribbon Settings

Chaase window to customize:
General Settings

Main Window v
Batch Table Settings .
Choose commands from: Customize the Ribbon, Toolbar, Menu:

Column Labels All - Ribbon Tabs -
Ribbon Settings

#of Levels: ~ File ="
Sample Types

<Separator> 4[] Home o=
Outliers B

About Quantitative Analysis Batch

Accept Assistant Curve fif* Samples

Accuracy Add >> 4 4 Analyze

Actions |~ Srara O Analyze % -

Add Calibration Quantitate | v

Add Column (2 Report

Add Samples View -

Add/Remove Columns Tools om

Add-ins

Advanced Tasks Y - New - Properties...

Flavor Settings

2 Intheleft pane, select Zero Peak, and click Add to add it to the Analyze menu.

|- Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis P- 0 X

Ch S

Reload Reset to Save
Settings Default Settings

Ribon Settings

Flavor Settings <& || Ribbon Settings

Choose window to customize:
General Settings

Main Window -
Batch Table Settings N
Choose commands from: Customize the Ribbon, Toolbar, Menu:
Column Labels Al - Ribbon Tabs .
Ribbon Setfings
4 %- Auto Scale = File o=
Sample Types 1
4 - Auto Scale 4 [ Home s
OQutliers
4 X- Auto Scale Batch
& %~ Auto Scale > samples
Add >> “
X - Log Scale - o) B ~
Anal v
% v AutoScale << Remove ) Analyze | v
Quantitate |~
$ ¥ AutoScale .
2 Report
% - AutoScale ==
View s
1 v-AutoScale
Tools cis
¥ - Log Scale
i zero peak
v New  w | Propertes

Flavor Settings
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3  Customize a Flavor
Create a Custom Ribbon Button

3 Select the Zero Peak button in the right pane, and click Properties.

Ch S

Reload Reset to Save
Settings Default Settings

Ribon Settings

Flavor Settings
General Settings
Batch Table Settings
Column Labels
Ribbon Settings
Sample Types

Outliers

Flavor Settings

Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis

< | Ribbon Settings

Choose window to customize:

Main Windaw

Choase commands from:
Al

4 X-Auto Scale
4% X- Auto Scale
4% X- Auto Scale
4 X-Auta Scale
X - Log Scale
4 v-Autoscale
% v-Autoscale
$ v-AutoScale
$ v-Autoscale

¥ - Log Scale

AZEm Peak

Add >>

<< Remove

Customize the Ribbon, Toolbar, Menu:
Ribbon Tabs

File
") Home
Batch
[ samples
4 4D Analyze
AZem Peak
4 Analyze
Quantitate
(% Report
View
Trnic

New - Properties...

f

N oo g b~

In the Custom script execute field, enter

Select Image only from the Minimum size list.

ZeroExceptionPeaks.Execute(ToolState, UlState).

8 Inthe Custom script set state field, enter
ZeroExceptionPeaks.SetState(ToolState, UlState).

9 Click OK.

Quant-My-Way Flavors Setup Familiarization Guide

Select Image and text (Large) from the Maximum size list.

In the Custom script module field, enter ZeroExceptionPeaks.
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3  Customize a Flavor
Create a Custom Ribbon Button

Button Properties x
10 ChromSpec.ZeroPeak
Caption Zero Peak

Use default caption
Toaltip Zero Peak

Use default tooltip

Minimum size Image only -
Maximum size Image and text (Large) -
Small image

Large image

Custom script module | ZeroExceptionPeaks
Custom script execute | ZeroExceptionPeaks Execute(ToolState

Custom script set state FeroExcepn’onPEak.SetState(TcolState

e

10 Click Save Settings.

H - Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis = ml
Reload Reset to ve
Settings  Default Settings
Ribon Settings
Flavor Settings « || Ribbon Settings
General Settings Choose window to customize:
Main Window v
Batch Table Settings N
Choose commands from Customize the Ribben, Toolbar, Menu:
Column Labels Al = Ribbon Tabs -
Ribbaon Settings
#of Levels: & © File om
Sample Types
<Separator> 4 [ Home om
Outliers - -
About Quantitative Analysis I Batch
Accept Assistant Curve I [ Semples
Accuracy Add >> 4 1) Analyze 7S
Actions |~ e )\ zero peak ol
Add Calibration O Analyze |~ L 1
e Colurmr Quantitate |~
Add Samples =
(" Report
Add/Remove Columns
WView =5
Add-Ins I Tankc Y
- Advanced Tasks v e +| [ Fropertes...
Flavor Settings :
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4 Share and Install a Flavor

Make a Flavor Available for Use 32

Install a Flavor 36

You can make custom flavors available to others in your organization to install
and use in Quantitative Analysis.

Quant-My-Way Flavors Setup Familiarization Guide

31



4  Share and Install a Flavor
Make a Flavor Available for Use

Make a Flavor Available for Use

After you have created a custom flavor, you can make it available to others in

your organization to use for data analysis by deploying it in the Quant-My-Way
program.

1 Opetn the root folder of the flavor you would like to make available for use.
2 Click Deploy.

B - Agilent MassHunter Quant-My-Way Flavors Setup - Data Analysis ? - 0 X

Ch )

Open Root Deploy
Folder

Manage

Flavor Root < || Manage Flavors
CEERERATE Flavor root folder:
D-\My Root Folder

Flavars:

New Copy Edit Delete Test

Dats Analysis

Flavor 1

Flavor 2

Flavor 3

Flavor Root

3 Use the default Destination, or enter the folder path where you want to save
your deployment file.
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Make a Flavor Available for Use

4 Use the default installation file name, or enter a new name. The date is used
for the default name. The default file name format is
'yyyy-mm-dd.quantstups’. If a file with the default name already exists, a
hyphen and sequential number is appended to the file name (for example,
'yyyy-mm-dd-2.quantstups’).

Deploy Flavors x

Destination:

C\Users\lg\Desktop' My Root Folder\2017-08-15 quantstup

Deployment type:

@ Embed all contents
Deployment file will contain all configuration files

() Link
Deployment file will contain links to configurations

Configurations to degloy

Data Analysis
[ Flaver 1

[ Flaver2

[] Flaver 3
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Make a Flavor Available for Use

5 Embed or Link the flavor configuration to the installation file that will be
created for this deployment.

+ Inan embedded deployment, a flavor will remain as it was configured when
it was installed on a workstation. The flavor folder is copied to the client PC,
and the necessary files are distributed to client PCs. When extracted, the
extraction tool extracts all flavor settings files. The desktop shortcut points
to the extracted local flavor folders.

In a linked deployment, a flavor will update whenever it is updated in the
Quant-My-Way Flavors Setup program. The flavor folders are shared by
clients, and the pathnames to the centralized location are distributed. When
extracted, the extraction tool reads the pathname to the flavor folders. The
desktop shortcut points to the centralized network flavor folders.

Deploy Flavors x

Destination:

CA\Users\|p\Desktop My Root Folder\2017-09-15.quantstup

Deployment type:

'@ Embed all contents
Deploymeant file will contain all configuration files

~) Link

Deployment file will contain links to configurations

Configurations to deploy
Data Analysis

[ Flaver 1

[ Flavar2

[ Flavor 3

coe
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6 Select the Configurations to deploy. Multiple flavors in a root folder may be
deployed as a group. Installing this deployment file will install all the flavors
selected.

Deploy Flavors x

Destination:

C:\Users\p\Desktop\My Root Folder\2017-09-15.quantstup

Deployment type:

@ Embed all contents
Deployment file will contain all configuration files

() Link
Deployment file will centain links to configurations

Configurations to deploy

I Data Analysis
[ Flaver1
[ Flaver 2
[ Flaver 3

| OK | | Cancel |

7 Click OK. A deployment file (QUANTSTUPS File) is created. The deployment
file is used to install the flavors included in this deployment onto the
workstation where you want to use them for data analysis.

= BR[|
@@-\ . » MyRoot Folder » [ 49 ][ search My Root Foider r
Organize » =) Open = Share with New folder =~ O @
S Favorites Name Date modified Type Size
\. Flavorl 9/14/2017 9:19 AM File folder
B Desktop || Flavor2 9/14/2017 920 AM  File folder
|| Flavor3 9/14/2017 9:20 AM  File folder
| [E 2017-09-15.quantstups 9/15/2017 858 AM  QUANTSTUPS File 1KB
oy 2017-09-15.quantstups Date modified: 9/15/2017 8:58 AM Date created: 9/15/2017 8:58 AM
- QUANTSTUPS File Size: 629 bytes
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Install a Flavor

After the custom flavor is deployed, it is available to you or others in your
organization to install on a workstation for quantitative analysis.

1 Install MassHunter Workstation Quantitative Analysis B.09.00 on the
workstation where you want to install the custom flavor. The Quant-My-Way
Flavors Setup program is not required to install a flavor.

2 From the Windows directory on the workstation where you want to install the
flavor, navigate to and open the deployment file (QUANTSTUPS file)
containing the flavor you want to install.

3 Inthe Extract Deployment File window, use the selected Deployment file, or
browse to the QUANTSTUPS file you want to install.

4 Use the default Destination folder, or enter the folder path where you want to
save your flavor files.

. Extract Deployment File

Deployment file:

My Root Folder,2017-09-15.quantstups

Destination folder:

C\MassHunter\configuration\Quant\flavers

s

5 Click OK. The flavor is installed on the workstation, and a shortcut icon to the
flavor is added to the desktop.

When the flavor is launched for use, the Quantitative Analysis user interface will
be displayed in the Windows operating system language of the workstation
where it is launched.

6L/

Data Analysis
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